Contents at a Glance

JHEPOAUCTION ..eeeeeeeeeeeeeeeeaaeeeeennaaaeeeennnaseeesnnnsseeeennnsaneee ]

Part I: Introducing Mac 0S X Tiger ........ccccuecaveneacnacesd

Chapter 1: Mac OS X Tiger 101 (Prerequisites: NON€) ........cccooceiviriinienenenencneeeenens 11
Chapter 2: I Think Icon, I Think Icon . .. ... 27
Chapter 3: About Windows (Not the Microsoft Kind) and Menus ...........cccceecveueee. 53

Part II: Rounding Out Your Basic Training ...................95

Chapter 4: Newfangled FINAEr .........ccocvviiniiiiiiiiiieeiecectesteseeeee et 97
Chapter 5: Mastering the Save Sheet and the Open Dialog ........cccocceeieiievienenenenne 117
Chapter 6: File Management without Tearing Your Hair Out ........ccccocevvienviinnncen. 133
Chapter 7: Haggling with Removable Media ........ccccooceveieriiiniiniinieinienieeieeeene 161
Chapter 8: Back Up Now or Regret It Later ..........ccceeveeeieeiiiiienieneeeeieeeeeeeeeene 169
Part 111: Doing Stuff with Your Mac ............ccoueeeaeee 177
Chapter 9: Internet-Working ............ccccoveririininieneneeeeeteee ettt 179
Chapter 10: Publish or Perish: The Fail-Safe Guide to Printing ..........c..cccccervrenn. 203
Chapter 11: Application OVErload ...........cccovieviiieiiiiciieieece et 223
Chapter 12: The Classic Environment: Like Mac OS 9, Only Better ........................ 257
Chapter 13: What Your Mac Prefers ..o 271
Part IU: Networking & Troubleshooting ......................305
Chapter 14: Mine! Miiiiine! Sharing Your Mac and Liking It ..........c.cccocovevvieiieenennnn. 307
Chapter 15: Troubleshooting Mac OS X .......ccocvveriiririeieiererieseee et 347
Part U: The Part of Tens .........cccceeeeacceeeeecaaceeeeecaaaeec 359
Chapter 16: Ten (Or So) Ways to Speed Up Your Mac Experience .............ccceuvnee. 361
Chapter 17: Ten (Or So) Ways to Make Your Mac Better by Throwing

MONEY At I ..ottt sttt 371
Chapter 18: Ten (Or So) Great Web Sites for Mac Freaks .......c.coccceevevnenenncnnene 377
Chapter 19: Ten (Or So) Mac OS X Apps That You Might Need Someday ............. 381

Appendix: Installing or Reinstalling Mac 0S X
10.4 Tiger (Only If YVou Have To) ........ccccceeeeeeeeannee. 389

Indes ......neeaaaeaaeaaaceaaeaceecceaceeneenneaneenceaneaseenceasees 39T






Table of Contents

JHEPOAUCEION ...aeeeeeeaeeeeeeeeaeeeeeennnaeeeeeennaseeeeennnsseeeennnasaees ]

ADbOUt This BOOK ...c.eoriiiiiiiiiiiiieetetcttee ettt 1
What You Won'’t Find in this BOOK .......ccccceeieiieciiiiicececeeeeeeee e, 2
Conventions Used in This BOOK .........ccccceciiviieiiieiiiniiiieececeeeee e 3
What You're Not to Read ........ccoeevvieiiiiiiiiieccecececeeee e 4
Foolish ASSUMPLIONS .....cooviviiiiiiiiirieeeectce ettt 4
How This Book Is Organized ..........ccooceeviiniinieiiieniinienieneeieeieeieeieseeeenn 4
Part I: Introducing Mac OS X ......cccceeieeienieeeieeieeee e 5
Part II: Rounding Out Your Basic Training .........ccccecceeeeveienenenennenns 5
Part III: Doing Stuff with Your Mac ........cccccevievieiiiccieciecieceeeeieee, 5
Part IV: Networking and Troubleshooting .........c.cccecevviiniiniineennennee. 5
Part V: The Part of TENS ......cccocevciiviinienieieecieeieeeeteeeese e 6
The APPENdiX ......ccoiiiiiieeiiecee ettt e ere e tae e sereeene 6
Icons Used in This BOOK ....c.cccocuiriiniiniiiiiticecceceteeeeee e 6
Where to GO from HETe .........c.ooovieiieiieiicieceeeeeceeeee e 7

Part I: Introducing Mac 0S X Tiger ........cucceeeeeceneicnaeacd

Chapter 1: Mac 0S X Tiger 101 (Prerequisites: None) ............. "
Gnawing to the Core of OS X ....cooiiiiiiiiiiieieteeeeeee e 12
A Safety Net for the Absolute Beginner (Or Any User) .........cccceevveenenne. 14

Turning the dang thing on ........c.ccoevviiiiiiniineeee 14
What you should see on startup ........cccceeceevveeiniiencienieenieeeieeeen, 15
Shutting dOWN PrOPEILY .....ccccvveeiiiiiriiieeeieeeeeeeee e 18
A few things you should definitely NOT do with your Mac ........... 19
Point-and-click boot camp .........cccceeeiiiiiiiee e, 20
Touring the DeSKtOD ......cocevviiiiiniiriiieieeeeeeeee e 21
Sniffing Out the Default Desktop ICONS ........ccccoveviriiciiniereeeeeeeee, 23
Picture This: A Picture on Your Desktop ......cccccceecvevienieneecieecieeieeieeeene 24
Chapter 2: 1 Think Icon, I Thinklcon... ......................... 21
What You Get (In @ StoCk DOCK) ....ocviviiiiiiiiieieeiecieeeceeeeeeeee e 27
A quick introduction to using the Dock ........ccccceevveeviincieniinienenen. 28
The default icons of the DOcK .........ccoceevievieriiiniiiniiinienieneeecieeiee 30
Don’t want it? Trash it ......ccccecevviiniiniieeeceeeeeee 31
Delving Deeper into the DOcCK ........cccoeoiiecieiiiieieceeeeeeee e 32
More about DOCK ICONS .....cceeviiiniiiriiiiiniinierieeteteieeeeee e 33
Resizing the DOCK ......cccieiiiiiieiieiecieseeeee ettt 33
Adding and removing Dock iCONS ........ccccoccvevieniienieniienieeieeeeseenens 34
What should you put in your Dock? ........cccoevveviiviniiiniiniineeeeen. 36

Setting your Dock preferences .........c..coceevervienvieniieniieneeneeneenieniens 38



X’ii Mac 0S X Tiger For Dummies

Other Icons in OS X TIZET .....cooervieriirierieriertententese ettt 39
Aliases: Greatest Thing Since Sliced Bread .........ccccoceceeviivenenenencnenne, 42
Creating aliaSes ........coceviererireeeeeeeee e 43
Deleting aliaSes .....cccceevieriieiieeiieeieciesteseee ettt 44
Hunting down an alias’ parent ............ccocceevevviervieniiencieneeneeneeneeeens 45
Doing More with YOur ICONS ........ccccevivniininieniinienieeceeieeeeese e 45
Open sez me! Opening iCONS .......cccceeverviirvieriienieenieneeneesieesieeee e 45
Getting rid Of ICONS ....cceeeeieiieiiceeecece e 46
Playing the icon name game: renaming iCONS .........ccccceeverueecvennnnns 46
Selecting multiple iCONS ......ccccceviiriiiiirieeceeeceeeee e 47
INFO-MALION ..ot 49
Chapter 3: About Windows (Not the Microsoft Kind) and Menus .. .53
Anatomy of @ WINAOW .......ccccviiiviiiiicciceceeee ettt 54
Top 0’ the WINdOW t0 Ya! ...ccecvieeirieieeeeceeeeeee s 56

A SCYOIl NEW WOTLA ..o 56
(Hyper) Active WINAOWS .......ccoeviririenieenenieenceeeseeeeneereeecsreseene e 58
Dialog Dealie-BOPPEIS ....cc.cccuieiieiicieeeieetteieete ettt 59
Working with WINAOWS .......ccciiiiiiiiiiiiiiieeeeceeeeee et 61
Resizing WINAOWS ......cocuiiiiiiiiiiiiinientccce ettt 62
Resizing windOw PAnES .........cccceviiriiniiniiiienienieseesteseese e 62
MOVING WINAOWS ....ovuiiiiiiiiiiiiieitceeieste ettt ettt 62
Shutting o' WINAOWS ......cccoeriiririeieieieeceeteee et 62
MENU BASICS ..ouviiiiiiiieieieee ettt 63
Contextual menus: They’re SO00 SENSItIVE .......ccceeveveerieerieeciennnns 65
Disabled OPIONS .....cccccciiriiiiieieeieeieeeeee et 67
SUDIMENUS ...cvveiiiiniiiiieiteteeereeieeeetetet ettt sae e s ees 68
Keyboard shortcut commands ..........cceceeverviinvieniieniienieenenneeeeiee 68

It's @IlPLICAL .eevieeieeieieeee e 71
Underneath the Apple Menu Tree ..........cooovevinininieiienieeneeeeeceeeeenes 71
Your Constant Companion: The Application Menu .........cccccceevvevueecvennnne 74
File Management and More: Meet the File Menu ..........cccoccvvviivvienvennnnne. 78
The Edit Menu (Which Shoulda Been Called the Clipboard Menu) ........ 82
Comprehending the Clipboard ...........cccoovirviiniiniiniiniieceeieniee 83
Checking out the main Edit menu items ...........ccccecevevenenincnnennns 84

A View from a Window: The View Menu .........ccccocevviiiiiiinenenenencniene 85
Going Places: Checking Out Go Menu Items .........ccccceeeevierciieciencienceenneenne. 87
WiINAOW DYESSING .....covuiiiiiiiiiieiieieeiesteseese ettt e e see e e e e esaeessesnseens 89
Not Just a Beatles Movie: Help and the Help Menu ...............ccveeunennee. 91

Part II: Rounding Out Your Basic Training ...................95

Chapter 4: Newfangled Finder .........................cciatt. 97

Getting to Know the FInder .........ccocovvieviieiiniiiniieeeececeeeeeeee 97
Belly Up to the Bar(s): The Toolbar and Sidebar ..........cccoccvrvvervieniennnnnne. 99



Table of Contents

Navigating the Finder: Up, Down, and Backwards .........cccoccecevvevinenen. 101
Like a roadmap: The current folder drop-down menu ................. 101
Hither and yon: The Forward and Back buttons ........................... 103

Customize Your Finder WindOws ........c.ccoceoveriiiiiiieneniniineneeeeieseseniene 103
COIUIMN VIEW ..ottt sttt ettt sneas 103
[COM VIEW .ottt sttt a e s sse et nennees 105
LISt VIEW ..eeniiieiieeeteeee ettt sttt snesnees 105
On Using VIieW OPIONS .....cccoeieiieiiiriirierieteceieese et 108

Making It Your Very Own Finder: Introducing Finder Preferences ....... 112
Using the General PAne .........ccccoecvevienieniecieecieeieeieeeeseeese e eve e 113
Using the Labels Pane .........cccocevcievienieneeniieienieeeeseeseeneesie e 114
Using the Sidebar pane .........cccocevienieninniniiniinieneeeeeeeeee e 114
Using the Advanced Pane ..........cccccoceveeereeienieneneeeeeeeeeesee e 115
Customizing the Finder with Folder Actions ...........ccccceevecveennenen. 115

Chapter 5: Mastering the Save Sheet and the Open Dialog ....... 117

Saving Your Document Before It’s Too Late .........ccccceevevieciiecieecieciennn, 118
Checking out the Save sheet .........ccocoviiiiiiiinineeee 119
Looks like Save, acts like Save — why’s it called Save As? .......... 128

OPEN SEZ ME ..ottt ettt ettt ettt ae bbb st e e besanesanens 129
Knowing the differences between Open dialogs and

Save SHEELS ....occovviiiiiirec e 130
Knowing what the Open dialog doesn’t show you. .. ................. 131
Chapter 6: File Management without Tearing Your Hair Qut ...... 133

Working with Files and Folders ...........ccoocovininieinnienineeeeeeeeeee 134
Files versus folders ........cocoiviiiiineninineeieeeee e 134
Creating new fOlders ........ccccovierieriieiiieiicieceeeeceeeee e 135

Navigating Nested FOIders .........ccoviiviiniininiiiniecienieseeeeieeeeeeeneeenn 136
Moving files and folders .........coceververiiiriiiniinieniceeceeeeee e 137
Copying files or folders ........cccvviiverienieniiiieeeeceeeeeee e 138
Opening files with drag-and-drop .........cccccoeeveeveeeierienieceeceeeee, 140
Assigning an application to a document or document type ........ 142
Organizing your stuff with subfolders .........ccccccoevveiviiniininneninnen. 143
Spring-loaded fOlders ........cccvverviiniiniineeiicieeeeeeeeeee e 144

Getting Up to Speed with the Mac OS X Folder Structure ..................... 146
The Mac OS X folder structure in depth ..........ccoeeeiiieiciiecnnnen. 147
There’s no place like Home .........cccocoevirieieiinieneneceeeeeee e 150
Your Library Card .......ccccoceeeieciiiiieiecieeeeeeseeeete et 152

Finding Your Stuff, Fast ..........ccooieieiiiieececeeeeeeeeeeeee e 153
The Search box in Finder windows ........c..cccceceveneninnncncncnennn. 154
SPOLHZNT ..o 156
SMArt FOIAETS ...cuoviieieiieceeeeeee e 158

Chapter 7: Haggling with Removable Media .................... 161

Comprehending DiSKS ........ccccooviiveriiiniiiniienienieteteeeeeeee e 162

Some Disks Need to be Formatted First .........ccocooecneniincninncncicnene. 162

Moving and Copying Disk ICONS ........cccccoviririiiiiiiiieiieeeeeeeee 163

XI



Xi(/ Mac 0S X Tiger For Dummies

Surprise: Your PC Disks Work, TOO! ........cccocvieeiiieciieeeeeieeee e 163
Burning CDs and DVDS ........ccoocooieiiieieeeeeeeeee et 164
Getting Disks Out of YOUr MaC ......cccooeviinininieieieececeeee e 167
Chapter 8: Back Up Now or RegretltLater ..................... 169
Backing Up Is (Not) Hard t0 DO ......cccooevevininiiieieeeeeeeeeee e 170
Backing up by using the manual, brute-force method .................. 170

Backing up by using the manual, brute-force method
with Burn Folders ........coccooiiiininininecceeeeeceeee 170
Backing up by using commercial backup software ....................... 171
Why You Need Two Sets of Backups .......cceceeceriievieneninenceceeieeeee 174

Part I11: Doing Stuff with Your Mac ............cccoueieeneee 177

Chapter 9: Internet-Working ...................cooiiiiiiat.. 179
A Brief Internet OVErvIEW .......occocevvierienienienecieeiesteneest et 179
Setting Up for SUIfing .......cccoceviiniiniiiiieeteteeeee e 180

It starts with the modem ............ccccciiniiiiiiiceee 181
High-speed connections ........ccccccoeeeeieneecieecieesieeieeeeseesee e 182
Your Internet service provider and YOU .........cccceeeeevieeciencieneeneenns 182
Browsing the Web with Safari ........ccoceviiniiiiniinieee 183
Getting up and running with Safari .......ccccoecevvniiniinninninin, 183
Searching with Sherlock ..o 187
A quick look at Sherlock’s features ...........cccooveeeeeceeecienciencieeiennenns 188
Searching with Sherlock ........cccccooeieeienieiiecieeceeeeeee e, 188
Checking out Help Center .........cccceeveeviieiinienieneeceeseeeeieeve e 191
Getting Your E-Mail with Mail ........cccocoevviiniiiniiiniiiiicccececcceeeeene 191
CompoSing @ NEW MESSAZE .....eevverrervueriierierieneeneesieesseesseessesssesees 192
Checking your mail .......cccooceviriiininiiiieneeeeeeeeeeeeee e 193
Dealing with SPam ........cccooceviririireieee e 193
Changing your preferences ...........coccoeeeeveecienenenieneeieienene e 194
But wait — there’s more! ... 195
And don’t forget Address Book .........ccccevvevinininicecieieeeeeee 195
A QUICK OVErview Of IMAC ......coouviiieiiiiiieieicceieeec et 197
Communicating via iChat AV ...ttt 199
Gimme an A! GIMME @ V! ..oooooiiiiiiieeeeeee ettt 200

Chapter 10: Publish or Perish: The Fail-Safe Guide to Printing ....203
Before Diving IN . . . oo 203
Ready: Connecting and Adding Your Printer ...........ccocooeevnvnnininenennn. 204

Connecting your Printer ..........ccoccevveevieevieecieniienieseeseeseeseeseeeve s 204
Setting up a printer for the first time .........ccccocevvierviincininnenenen. 206
Set: Setting Up Your Document with Page Setup ........ccocevvvvinniencinnncnn. 209
Go: Printing with the Print Sheet ........cccociiiiiiiniiiee 211
Printing a dOCUMENt ......ccooeviiriiiiieieee e 211
Choosing from among different printers ...........cccocvveveienenenene 213

Choosing custom Settings ........ccccoeveeveevieeciensienieneeeeeee e 213



Table of Contents

Previewing Your DOCUMENLS ........coceeviiiiiiiniiniiiniinienteececieeee e 217
JUSTthe FaX . . . oo 218
FONt MANIA ...iciiiiiiieiieceeieeie ettt te et e te st e sae e reebeesteebeesaesnnans 219
Installing NEewW fONtS .......cccceeviiecieriiiiieeeeeeeee e 221
TYPES Of fONES .ueiieieiieiieieeeceeeee e 221
Chapter 11: Application Overload ............................. 223
Folder FUll Of APPS ..cvvoviiiieiieiieiecececteeetee ettt 224
Address BOOK .......cocooviiiiiniiiiniiciecetetetee ettt 224
Apple Graphing Calculator ........c..cocevieviinieninneneneeeteeeeee 224
APPIESCIIPL .t 225
AULOMALOY ...oiiiiiieeiieceeeeeeece ettt e et ssaesae e aeenes 226
CalCUIAtOr ...oceiieiieiiceeee e 229
CRESS .ottt et ettt ettt et et 230
Dashboard .........ccoocieeiiiiiiiiieeeccteee e 231
DICHONATIY ...eeiiiiiiiieiteieee ettt ettt et et 236
DVD PIAYEY ..ottt ettt sttt ettt 236
FONt BOOK ..ottt 237
HCAL cuvieiieieeeeeee ettt ettt et e st et aeeaeenbeennas 239
ICRNAL ettt 240
IMAage CAPLULE .....ccvevuiiiiiiieieeeeteetete ettt 241
Internet CONNECE .....ccccoviiiiiiienierietete et 241
ISYIIC ettt aeas 241
ITUNES oottt ettt te e et aeeaeenseennas 242
VAL <.ttt 242
PIEVIEW ..ottt sttt 242
QUICKTIME PIAYET .....ooviiiiiiiiiiieieceeeeece ettt 242
SALATT ettt 242
SNETLOCK ...eiiiiiieieeeee et 243
STHCKIES oeuviiiieiieiecieeeesit ettt et te s e ste et e e te e steeae s e e sbaesseeseaensaennas 243
System Preferences ........cccoovveeeiiiienieneecieeieeieeteeee e 244
TEXTEAIL ..ottt e 244
UHIHES ©oonveeiieieeieeeee ettt 244
Chapter 12: The Classic Environment: Like Mac 0S 9,
OnlyBetter .........coiiiiii it 257
You Can Call It CIaSSIC ...ccvevverveeiieeeieieiesesesteeeee ettt ereeeas 258
What’s so great about ClassiC? ........ccocevveeveininnenieniienienieneeeene 259
Doin’ the Classic danCe ........ccoccoveverivrceeiieieeeseeeeeeeeeee e 259
Working with ClassicC .......cceceririririieieeeee s 260
Launching Classic (or letting it launch itself) .......ccccoceceiininnnen. 260
Opening a ClasSSiC aPP ...ccceeveereeneenieenieerieeieeieseeseeseeesseesseesseesseennes 262
Getting oriented (“Toto, we’re not in OS X, anymore . ..”) ......... 263
Getting back to OS X ..ot 265
Setting Classic preferences ........cc.coeeveevervenviensienieeneeneeneeeeees 265
Getting more info on ClasSiC ........cccceceeviieiiecieeieeeeeeeeee e, 267

Booting from Mac OS 9.2.2 .......cccoooieeieeeeeeeeeeee e 267

xv



X(/i Mac 0S X Tiger For Dummies

Chapter 13: What Your Mac Prefers ........................... 2n
Introducing System Preferences .........ccccoeveeveevieniieneenieeneeneesieeceeneens 271
Using System Preferences .........cccocovevieenienieniieniienieneeseeieeieevesne s 272

Unlocking a preference .........coccocevievieneenieniennienienceseeseeseeeeeeees 274
Locking a preference ..........ccccceecieeeeeecieecieeceeeeeee e 276
Setting Preferences .........coccovoveeieieieniereseeeeeeee et 276
Personal Preferences ........cooiiiieienieneecieeceecieeee e seesee e 276
Hardware Preferences ..........ccocevvevienieneecieesieeieeieeeeseese e 286
Internet & Network preferences .........cccccceevevvenvienieeneeneeneeneennne. 292
System System preferences (kind of redundant) ...........ccceeuenee. 296

Part IU: Networking & Troubleshooting ......................305

Chapter 14: Mine! Miiiiine! Sharing Your Mac and Liking It ...... 307
Introducing File Sharing ........ccccoceevieriiiienieececeeeseeeee e 308
Portrait of home office networking ..........c.ccccovvevvienviiniininnennnnen. 310
Three ways to build a network ........c.ccooceviiiinniniiniieee, 310
Setting Up File Sharing .........ccccceevueeieeieiieeeceeeee et 312
Turning on file Sharing ..........ccccoceveiininiieeeee 312
Starting ApPPIETalK ......cccccoieviieiieieciecteeeeee et 314
Sharing With TCP/IP .......ccceevieiiiiiiieeeeececeeee et 314
Access and Privileges: Who Can Do What .......cccoccoeviiniiiniiniinininenee, 316
Users and groups and GUESES .......ccceeceevierrieriieriienieneeneenieesieseennees 316
Creating USEI'S ......ccccveeveeieriieiieesieeieereeteereeaesee e e e e be e seeseesseeanes 317

Mac OS X knows best: Folders shared by default ....................... 323
Sharing a folder or disk by setting privileges ..........ccccccevverueennenen. 324
Useful settings for access privileges ..........cccccevvvvierceeneeneeneenennen. 329
Consummating the Act of Sharing ........ccccceeceviiinviinienieinenieneeeeene 332
Connecting to a shared disk or folder on a remote ...................... 333
Unsharing a folder ..........cooovieviiiiiiiinieeeeceeeeeee e 335
Disconnecting from a shared volume ..........ccccocevevircnnecienennnen. 337
Changing your PaSSWOTd .........cccceeeeevieeiieeieeieeeeneeseeseeeseeesaeeveennas 337
Setting up shortcuts to remote volumes (and folders) ................ 339
Connecting to your own computer from a remote computer .....340
Chapter 15: TroubleshootingMac 0S X ........................ 347
Dem OI’ Sad Mac Chimes of Doom BIUES .........cccoceviiniinenniinniinienieene 347
The ultimate startup disk: The OS X installation CD .................... 348
Booting from CD-ROM ........cccccciiiiiiiieeeeceeeceee et 349
Question Mark and the Mysterians ...........coccecevevieneniniinieneeeeneceeene 351
Step 1: RUN First Aid ....c.ooooveeiieiieieieieeeeeeceee et 352

Step 2: Safe Boot into Safe Mode .........ccceeevveviirviiecienienieeeeeeee, 354

Step 3: Zapping the PRAM ........cccooviiioiiieicreeeseeeeeeeeere e 356

Step 4: Reinstalling OS X ....ccooieieieriieieeeeeeeeere et 356

Step 5: Take your Mac in for repair .........ccccccvevieecieeeenieneeceenenen. 357

If You Crash at Startup ......cccooceeeeieiienieeneee e 357



Table of Contents X(/ii

Part U: The Part of Tens .........cccccceeeeecccacaeeeeeeeceeeaaaae 359
Chapter 16: Ten (Or So) Ways to Speed Up

Your Mac Experience ...............cciiiiiiiiiiiiiiiia 361
Use Those Keyboard ShOrtCuts ..........cccceeveeeieeciecienieneeseecieecieeieeeeeennn 361
Learn to TYPE BELLEY ......cooiviieiieieeeeeteeeeete ettt 363
Resolution: It’s Not Just for New Year’s Anymore .........cccoccevvvervvervennnnne 364
A Mac with a View — and Preferences, TOO .....cccoovvvveviviiviiiiiiieieiiiieinns 365

When bigger isn’t Detter ........ccccovivviiriiniiniiieeceteeeeee 366
Calculated MOVES .....ccooeeuieieieieiereseetetete ettt 366
Getting ahead-er and other stuff ..........c..cccoeveeveieviniieniieeeeee, 367
Get a New, Faster Model or Upgrade YOurs .........cccoceeveevieeciennieesvenceennnens 367
Get an ACCEIEIAtOr .......ccuevuiriiiieiieieieceree ettt 368
Get an Accelerated Graphics Card .........ccccccoveeviiieciieiieecie e, 368
Get a New Hard DIivVe .......coociviiiiiiiiiienientctctctee et 368
Add Storage with FireWire or USB 2 DIives ........cccooceviveveeceenienienenene, 369

Chapter 17: Ten (Or So) Ways to Make Your Mac Better

by Throwing Moneyatlt ...................ccoiiiiiiiiiiinnn, n
RAM .ottt ettt ettt st 371
Backup SOftWare ........cocooieiiiiieeeeee e 372
A Better Monitor (or a Second ONe) ........cccceeeveeeiieiieiiesieneeseeseeseeveenes 372
A Fast Internet Connection ..o 372
Additional Hard/Removable/Optical Drive(s) .......cccccecvercveneerenniercnennee. 373
GAIMES ...ttt ettt ae st a e b bt s et e aesaesre b ne 373
Multimedia TitIES ......ccocieriiriirieieieeeetete et 374
Some Big Honking Speakers with a Subwoofer ...........ccccocevvviiennnnnnen. 374
A New Mouse and/or Keyboard ..........cccoceeeeeviieiiieciieiecieceese e 374
A PowerBook or an iBOOK .......c.occoiiiiiiiniiiineeeee 375
ANEW MAC ittt sttt 375

Chapter 18: Ten (Or So) Great Web Sites for Mac Freaks ......... 371

Chapter 19: Ten (Or So) Mac 0S X Apps That You Might

NeedSomeday .............cciiiiiiiiiiiiii it eninneenns 381
WED SHATING ..ocvviieiiiiecieieeee ettt ettt e be e aeeaeeneas 381
FTP ACCESS ..ttt sttt s 382
ColorSYNC ULIILY ...ooviiriiiiiieeeiececesteeesteste sttt 383
IMAGE CAPLULE ..c..eiiiiiiiiieieeiesteetet ettt sttt et et ae s 384
TeXt tO SPEECH ..ot 385
VOICEOVET ...ttt ettt ettt ettt sttt et e se s e saeens 385
Speech ReCOgNition ........cccccveiieiieienieieeeece e 386
NetInfo MaANAZEY ......ccceecieviieiiieiieieeeere et eseesteeteetesteseeesteesseesseesaesaesneens 386
UNIX Tools: Terminal, Console, and Activity Monitor ...........cccccueevennen. 387

Terminal ...c..cooouieiiieieecee e 387
CONSOIE ..ottt 388

AcCtivity MODNILOT ..c.ooviiiiiiiiiiieiieeeteceeeeece ettt 388



X’(/iii Mac 0S X Tiger For Dummies

Appendix: Installing or Reinstalling Mac 0S X
10.4 Tiger (Only If You Have To) .........cccoueeecueeeanenne 389

How to Install (or Reinstall) Mac OS X .....cccccevirenirenenncncnieencneeeneenes 390
Getting Set Up with Setup Assistant



